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[Abstract] Improving crops against water deficits requires a better understanding of plant root system 

functioning. This requires a better knowledge of the water uptake process and to address the influence 

of root system architecture or root physiological properties on the uptake efficiency. To this end, we 

describe here a non-destructive system that enables a dynamic, quantitative, functional imaging of the 

soil water and of the root system, from the single root to the whole root system scale.  

  This system is based on plants grown in sandy rhizotrons and relies on the modulation, by soil water 

content, of the intensity of light transmitted through the rhizotron. Images of the transmitted light during 

plant water uptake (or release) phases are recorded with a CCD camera and water content can be 

related to the grey level of image pixels with a calibration. 

  This system is affordable and can be implemented relatively easily without specific equipment. It is 

scalable and quick to allow the phenotyping of a range of plant genotypes relative to their water uptake 

pattern. This pattern can then be related with root system properties (soil colonization, root architecture) 

at different plant stages. Combined with modeling, imaging results help in getting parameters such as 

root hydraulic conductivity, distributed root water uptake rates or root xylem water potential. Combination 

of modeling and experiment further helps in testing biological and physiological assumptions and in 

predicting the uptake behavior of plants in the field. 

Keywords: Imaging, Soil water, Roots, Architecture, Water uptake, Rhizotron 

 
[Background] During decades, detailed observation of water uptake by plant roots, as well as water 

flux trough roots and plants, has been technically challenging. Most of water uptake studies have been 

made by measuring soil water content variation with time. In the field, such measurements are based 

on the use of moisture sensors distributed in soil such as neutron moisture meter (Hignett and Evett, 

2002) or electromagnetic TDR or capacitive sensors (Li et al., 2002). In a controlled condition, with 

potted plants, the weight of the pot can be used to determine pot water content. However, if these kinds 

of measurements are well suited to describe macroscopic soil water behavior, they do not give access 

to detailed distribution of water around roots and to the interactions for water between roots. Also, they 

do not reveal the distribution and functioning of roots.  
  Concomitantly to moisture measurements in the field, root distribution can be assessed destructively 

with core samples, trench wall profiling or less destructively with mini-rhizotron imaging (Smit et al., 

2000). This gives access to a root distribution (of length, root impacts, biovolume) with depth. The 

variability in rooting needs generally to acquire a high number of samples, a difficult task as 
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sampling/measurements are highly time and labor demanding. 

  Plant and root hydric relationships can be examined with a variety of measuring devices. Sap flow 

can be estimated in stems and coarse roots with heat balance sap flow meters (Granier, 1987); root 

hydraulic conductance can be estimated from root segments to root systems with tension induced 

measurements (North and Nobel, 1995), root pressure probe (Frensch and Steudle, 1989) or pressure 

cell (Miyamoto et al., 2001). Root water uptake flux at the single root level can be investigated with 

potometer (Sanderson, 1983), dye tracing (Varney and Canny, 1993).  

  All these methods deliver complementary information/properties of the water-soil-plant system, but 

most of the time, measurements have to be conducted on excised root segments, roots or root systems 

separated from soil, or for plants grown in hydroponics. They also combine information on roots which 

might not be similar (e.g., root type, age or order, location within the root system). 

  Imaging techniques allow the observation of living root systems and their interaction with soil without 

the need of excising or extracting them from soil. They also enable to quantify root architecture and 

growth, root type and age if measurements are repeated in time. Ideally, imaging technique shall enable 

not only root imaging but also other parameters such as water content. Different imaging techniques 

have been used to investigate the water-soil-root system these last years. They differ in their ability to 

resolve roots or water, the size of samples, the 2D or 3D description, the tractability and accessibility. X-

ray scanning was first used in the pioneering work of Hainsworth and Aylmore (1983 and 1986). Since 

then, X-ray scanners highly increased in resolution, power and scanning speed as did image processing 

for roots tracking and segmentation in soil columns (Tracy et al., 2010). However, accurately quantifying 

water and roots in 3D soils is still a challenge (Zappala et al., 2013) as the technique shows almost the 

same response for water and roots, with a trade-off between resolution and size of the sample (Pierret 

et al., 2003a and 2003b). X-ray scanners are nowadays more accessible to soil/root researchers, but 

still not fully accessible and rather expensive. Magnetic resonance imaging (MRI), based on the H spin 

relaxation in a magnetic field, has shown high potentials for imaging soil and water (Pohlmeier et al., 

2008) because of its high sensitivity to water. However, the rather low resolution necessitates relatively 

small samples. Some natural soils cause artifacts in RMN due to their magnetic properties. A long 

scanning time is needed for imaging while low accessibility and high price make this technique presently 

not readily available for soil-root water studies. Neutron radiography (and tomography) has been 

recently introduced for imaging roots and water (Nakanishi, 2005; Esser et al., 2010). The technique is 

based on the attenuation of a thermal neutron beam and is highly sensitive to H atoms and water. It 

enables the imaging of roots and water at high spatial resolution (0.1-0.5 mm) and high precision of the 

water content (1 to 5 x 10-3 m3.m-3). The technique requires however rather thin and small root boxes 

(rhizotron ~30 cm). The production of a neutron beam, together with imaging capabilities, is possible 

only in a few places around the world and makes it hardly available for routine measurements.   

  A more accessible approach to study the soil-water-root system is the light transmission imaging 

technique, described in details in Procedure B. Originally set for studying water infiltration instability in 

coarse sand porous media (Glass et al., 1989), the design has been adapted to allow plant growth in an 

adequate sandy substrate in rhizotrons and for getting time and spatial variations of soil water. These 
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variations can then be linked to water uptake, in relation with root colonization and root system 

architecture (Garrigues, 2002; Garrigues et al., 2006). Making use of only rhizotron, camera and a light 

source, the technique is easily scalable for phenotyping a range of root systems in relation with water 

uptake properties (Lobet, 2013). Coupled with modeling and complementary data, the technique can 

give access to plant functions/properties such as the hydraulic properties of the root system, the root 

growth rate affected by water content… 

  It shall be noticed that all of the preceding imaging methods are adapted to the scanning of samples 

in the laboratory. In the field, Electrical resistivity tomography has a high potential for imaging soil water 

content and water uptake by crops with time (Srayeddin and Doussan, 2009) but presently no method 

is able to simultaneously image water and the roots in the soil. Root evaluation still mostly relies on 

destructive sampling for field studies. 

 

Rationale of the technique:  
The technique is based on attenuation of the light passing through a rhizotron, in which roots grow and 

take water up (Figure 1). The light attenuation is directly linked to the water content. The technique uses 

easily available materials, software programs and standard CCD cameras for imaging and is cost 

effective. As the measurement time is short, it enables a high temporal resolution. A high spatial 

resolution can also be achieved, on the order of 0.2-0.5 mm. The technique pipeline can be designed 

to allow for multiple rhizotrons scanning and monitoring over time, in order to phenotype a range of 

genotypes in relation with their water uptake/root soil colonization or root architecture properties (Lobet, 

2013). The measurements can be qualitative (i.e., quantifying only differences of water through time or 

between plants) or quantitative with a calibration step.  
  However, the light imaging technique has also drawbacks: (i) Plant roots grow in a thin slab of soil 

and is more a 2D than 3D approach. (ii) As the soil volume is rather low and soil hydric properties are 

those from a sandy medium, processes related to water uptake in soil (e.g., water drawdown near root, 

water deficit) are accelerated/amplified compared to a natural 3D soil (depending on the climatic 

demand). (iii) The soil in the rhizotron is specific (sand + clay) to be translucent and the technique cannot 

be used with a natural, opaque, soil. (iv) Bulk density of the soil is rather high, about 1.5-1.6 g/cm3, lower 

density results in a repacked soil which is not stable through time. At least for maize, lupine, Arabidopsis 

the bulk density and soil type did not impede/alter root growth.  

  To date, most applications with light transmission imaging have been water shortage experiments and 

analyze the water uptake pattern in relation with root distribution/architecture or root hydraulics (Figure 

2). However, this technique can be used to examine water uptake as a function of age/plant stage; to 

study interaction/competition between plant neighbors; to follow the effects with time of 

humectation/drying cycles; the interaction between localized irrigation and root growth/water uptake; 

split-roots or partial root zone drying can also be explored as well as root growth for various 

heterogeneous water content conditions or induction/regulation of aquaporins. Complementary data, 

such as leaf water potential, transpiration of leaves, or other physiological measurements can be of 

interest to examine water relations at the plant level. 
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Figure 1. Schematic layout of the experimental system for imaging roots and soil water 
content (reprint from Garrigues et al., 2006 with permission from Plant and Soil) 

 

 
Figure 2. Examples of results from Light transmission imaging of the soil-root system. A. 

Variation with time (after the end of irrigation) of the water content in the soil of the rhizotron. The 
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soil is colonized by a 50-days old Lupine whose root system is shown on the left. B. Water uptake 

rates of the Lupine in the rhizotron, derived from the difference between images of water content 

(shown in A) in the morning and evening. A downward and lateral spreading of uptake is visible. 

This spatial-temporal pattern depends on root architecture, root hydraulic conductance distribution 

in the root system and soil hydric properties. (Panel A is adapted from Doussan et al. 2006) 

 

Theoretical background: 
The principle of the technique relies on the fact that the light transmitted through a sandy porous medium 

(sand + air + water) increases with the water content. This variation in transmitted light intensity with 

water content is linked to the physical processes of reflection/refraction of light. Indeed, the light passing 

through the different phases of the porous medium is not only exponentially absorbed, but also reflected 

and refracted at the interfaces between the phases. For the later processes, the transmitted intensity of 

the passing light is a function of the refractive index of the two phases and angle incidence. The Fresnel’s 

law gives the light transmission ratio (τ = Iv/Ii; with Iv: intensity of transmitted light, Ii: intensity of the 

incident light) at the interface of two media for a normal incidence:  
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where n is the ratio of the refractive indices of the two phases. When using the refractive index of sand, 

water and air (1.6, 1.33, 1.0 respectively), the transmission ratio for the sand–air (τsa) interface is 0.946 

while for sand–water interface (τsw) it reaches 0.991 (Tidwell and Glass, 1994). Hence, when water 

replaces air at sand interfaces, the transmitted light increases.  

Tidewell and Glass (1994) generalized equation (1) to a whole porous medium, assuming that a pore is 

full or empty of water: 
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where Ivd is emergent light intensity of the dry sample, Kw and Ka are the light absorption coefficient for 

water and air, respectively; dw is the total thickness of water filled pores, S is the water saturation: S=θ/θs 

with θ volumetric water content and θs water content at saturation), k is the average number of pores 

across the sample.  

As Kw and Ka nearly equal, eq. (2) can be approximated by:  
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As the dry state for estimating Ivd is not readily attainable after plant growth in the medium and (3) is 

dependent on the bulk density of the sample, we can make use of the saturated state for normalization 

between samples. Using the ratio
vs

v

I
I∆ , where vI∆ = vvs II − , with Ivs the emergent light intensity at water 

saturation, equation (3) can be transformed to:  
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Based on (4), fitting a relationship between S and ln(1-∆Ιv/Ιvs) is the rational for calibration and the 

conversion of images’ pixel intensity into water content. 

 

Materials and Reagents 
 
A. Growing media for plant 

1. Filter paper 

2. Petri dishes 

3. Sand: “Fontainebleau sand” (VWR, catalog number: 27460.364, 5kg) 

4. Clay: hectorite (Elementis specialties: Bentone MA®) 

5. Coarse sand/gravel (2-3 mm diameter, such aquarium sand) 

6. Detergent: TFD4 (Dutscher, catalog number: 711169B) 

7. Nutrient solution: modified Hoagland solution (see Recipes, chemicals available from VWR, 

Fisher Scientific, Sigma-Aldrich, …) made with: 

a. KNO3 

b. Ca(NO3)2·4H2O 

c. Fe-EDTA 

d. MgSO4·7H2O 

e. NH4NO3 

f. KH2PO4 

g. H3BO3 

h. MnCl2·4H2O 

i. ZnSO4·7H2O 

j. CuSO4 

k. H3MoO4 or Na2MoO4·2H2O 

l. KOH  
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B. Construction of Rhizotrons (height x width from 30 x 30 to 100 x 50 cm) 

1. PMMA (Plexiglas/Perspex) sheets: Transparent and colourless, 5 mm thick (minimum)  

2. PVC rod: 1 cm high, 4 mm thick 

3. Aluminum flat bars: 4 mm thick, 1 cm width (see Notes) 

4. Corner shaped aluminum bar, 1 x 1 cm 

5. Stainless steel and nylon bolts (and nuts): 20 mm long x 3 mm diameter 

6. Black matt tape 

7. Plastics (PVC, PPMA, Altuglass) (is easily available from local retailers, e.g., Gaches Chimie, 

abaqueplast: abaqueplast.fr) 

8. Aluminum bars (available from local DIY stores) 

 

C. Construction of Light source and colorimetric scale (if needed) 

1. Fluorescent tubes (e.g., Philips TLD 18W/840–Cool white color) 

2. Wood or other materials for constructing the frame of the light illuminating box 

3. Light diffusing sheet of PMMA: 4 mm thick, white colored (Altuglass, catalog number: 100 27018) 

 
Equipment 
 

1. CCD Camera: 6 to 12 Mpixels, 8 to 14 bit depth for colors, RAW format available, computer 

driven interface for remotely shooting the picture and transferring the image file, manual 

adjustment possible 

2. Camera lens: 50 to 120 mm focal length, aperture ~f2-f22 

3. Tripod for camera 

4. Balance for weighing rhizotrons (20 kg range for the larger 1 x 0.5 m rhizotron) 

 
Software 
 

1. Image processing Software: Fiji (Schindelin et al., 2012, open-source software based on ImageJ, 

https://imagej.net/Fiji)  

2. For processing imaged root systems: SmartRoot (Lobet et al., 2011, Open-source, based on 

ImageJ, https://smartroot.github.io/) or for simple segmentation of root system (and length, 

diameter of roots): IJ_Rhizo (Pierret et al., 2013, Open-source, based on ImageJ, 

http://www.plant-image-analysis.org/software/IJ_Rhizo)  

 

Procedure 
 
Note: Depending on the material, equipment already available, not all of the steps below need to be 

completed. In particular, the first step (construction of equipment) can be skipped if already available or 

alternatives are available in the laboratory.  
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A. Construction of the equipment (rhizotrons, light source and water content calibration cells) 

1. Building of the rhizotrons: 

The rhizotron is a transparent box in which the soil is filled and the plant is grown. The faces of 

rhizotron are made of 2 transparent PMMA (Plexiglas) sheets. Height and width can be adapted 

to the root system of the plant studied. We used 100 x 50 cm for blue lupine and maize, 30 x 30 

cm for Arabidopsis. The thickness of plexiglass sheet is 5 mm to be sufficiently rigid. As an 

example of rhizotron design (Figure 3): 

a. The 2 Plexiglas faces are separated on left and right by rigid aluminum bars (width = 1 cm, 

thickness = 4 mm, see Notes, length = length of Plexiglas face). A corner shaped aluminum 

bar on each side increases the rigidity of the assembly (Figure 3).  

b. Some silicone grease is applied along the aluminum bars to make them watertight. 

c. For the bottom, a rectangular plastic (PVC) rod is used: ~1 cm high, thickness = 4 mm, 

width = width of plexiglass–2 cm (2 cm is the sum of the widths of the 2 aluminum bars) and 

perforated with 3 mm holes for drainage.  

d. Use 20 mm long x 3 mm diameter bolts (and nuts) made from stainless steel and nylon (~20 

stainless and 16 nylon for 100 x 50 cm rhizotron) to assemble the rhizotron.  

e. For each nylon bolt, a spacer is made by cutting a small PVC pipe (length = 4 mm, external 

diameter = 7 mm, internal diameter = 4.5 mm). These internal spacers are needed to inhibit 

lateral movement of Plexiglas sheets with time (particularly for large ones). We used a 

spacing of about 12 x 12 cm, vertical and horizontal directions, for internal spacers along 

the PMMA sheet for 100 x 50 cm rhizotron.  

f. Aeration holes (2 mm) are drilled into one face of the Plexiglas sheet. 

g. Black, matt, tape is put along the edges of the rhizotron 

Figure 3 shows assembling of rhizotron. The top of rhizotron can be enlarged by drilling in the 

2 Plexiglas to accommodate positioning of large seeds. An alternative design of rhizotrons can 

be found at files.figshare.com/224189/rhizotron_blueprints.pdf, from Lobet and Draye (UCL). 
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Figure 3. Rhizotron. Schematic assembling of a 100 x 50 cm transparent rhizotron (Left) and 

a picture of the assembled rhizotron (Right), with the installed coarse sand and gravel draining 

layer at the bottom. 

 

2. Constructing the light source (if not already done/available):  

A light source is needed to produce the light that will cross through the rhizotron and will be 

registered by the camera. The light box is made from a frame whose size accommodates the 

size of rhizotrons (Figure 4). We found it convenient to use wood to construct the frame. For 

example, for a large rhizotron 100 x 50 cm, the wood frame is 130 x 80 cm.  

a. Within the wood frame, the light is emitted by fluorescent tubes. For a large rhizotron, 19 

fluorescent tubes, 56 cm length, 18 W (Philips TLD 18W/840–Cool white color) are aligned 

along 116 cm height. For smaller rhizotrons, e.g., 30 x 30 cm, 4 fluorescent tubes are 

sufficient for illuminating a 45 x 40 cm surface area.  

b. The inner walls of the wood box shall be white to increase the light efficiency.  

c. For aeration and limiting heat, holes (~5-7 mm diameter) are drilled on the top, left and right 

side, of the wood box.  

d. Affix on the side of the light box facing the rhizotron a white, light diffusing, sheet of PMMA 

(4 mm thick), to homogenize the light from fluorescent tubes. It can be fixed with screws on 

the wood box. 

3. Setting a colorimetric scale 

Variations with time of the intensity of the light emitted by the light box or captured by the camera 

(because of variation in exposure time or thermal noise for example) might happen. To get rid 

of these variations not linked with water content in the rhizotron, a light transmission grey scale, 

acting as a reference for image adjustment, is needed. The grey scale also accounts for possible 

nonlinearity of CCD or camera built in process over the light intensity range recorded. The scale 
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can be constructed from more or less transparent PMMA materials. We found a better way to 

construct it by using 8 known grey values printed on normal paper by imaging software (ImageJ, 

paint…). The grey levels are: 10, 25, 50, 100, 150, 205, 233, 255, as coded for an 8 bit-grey 

scale image. The zero level (black) is taken from a black side of the light box. Each paper printed 

grey-values is sandwiched between 2 white diffusing PMMA light diffusing sheets, as above. 

PMMA and paper hold together with matt black adhesive tape. This results in rectangular blocks 

which are placed on a side of the light box with adhesive tape, setting a light transmission grey 

scale (Figure 4). 

 

 
Figure 4. Light box. Schematic assembling of the light box for back illuminating rhiztrons (Left) 

and a picture of the assembled light box, with colorimetric grey scale and a filled rhizotron, with 

narrow leaf lupine. During experiment the rhizotron was installed on the balance in front of the 

light box (right). 

 

4. Adjusting the light source to rhizotrons 

The light box shall be greater than rhizotrons, incorporating the colorimetric scale for getting 

homogenous light trough samples. It is necessary to create a mask of the size of the rhizotron 

fixed over the white diffusing PMMA sheet of the light box. The mask needs to be also adapted 

to the colorimetric scale, next to the rhizotron (Figure 4). This mask can be made from cardboard 

or be a wooden frame painted black. A black foam ribbon between the mask and the rhizotron 

will occult light there. If the rhizotron does not stay on front of the light box during the experiment, 

being removed after each picture, the rigid wooden frame can be adapted to serve also as 

rhizotron holder. It is indeed important that the rhizotron stays at the same place for each 

imaging experiment to get the best spatial precision in the images and in the geometric 

registration. A slide on the wood frame with wing bolts that press the rhizotron against the frame 

and foam ribbon will hold the rhizotron at the same position for successive imaging sequences.  
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5. Construction of water content calibration cells 

A calibration cell enables to fit equation (4) in the form 

 

𝑆𝑆 = 𝜃𝜃
𝜃𝜃𝑠𝑠

= 𝑎𝑎 + 𝑏𝑏 ln �1 − ∆𝐼𝐼𝑣𝑣
𝐼𝐼𝑣𝑣𝑠𝑠
� = 𝑎𝑎 + 𝑏𝑏 ln � 𝐼𝐼𝑣𝑣

𝐼𝐼𝑣𝑣𝑠𝑠
�                           (5) 

 

where a and b are to be fitted.  

The calibration cell is made from the same materials as rhizotrons. Aluminum bars (4 mm thick, 

1 cm wide, 14 cm length) are glued on to a transparent PMMA sheet (50 cm length, 14 cm high, 

5 mm thickness) to delimit 7 compartments, 6-cm width (Figure 5). These compartments will be 

filled with the sandy soil prepared in Step B1 at 0, 2, 5, 7, 10, 15, 20% gravimetric water content 

(g water/g dry soil). The water used is tap water. The front face of the calibration cell is another, 

removable, PMMA transparent sheet and holds in place with screws or clips. Black, matt, 

adhesive tape is put along the edges of the cell when finished and filled. Crosses (4) drawn on 

PMMA with a fine permanent marker serve as a spatial reference for image geometric 

registration. 

 

 
Figure 5. Scheme of the water content calibration cell. A frame of flat aluminum bars, 4 mm 

thick, is sandwiched between 2 transparent PMMA sheets. The aluminum frame delimitates 

cells which are filled with sandy soil of known gravimetric water content. 

 

B. Experimental procedure 

1. Preparation the soil growing medium 

The soil used for growing plants in rhizotrons is a sand-clay mix. The sand is “Fontainebleau 

sand”, a clear, pure, silica sand with a mean diameter of about 200 µm. The clay is the hectorite 

(swelling) clay, which is transparent when mixed with water. Sand hydraulic properties may 

depend on how the sand is clean at the beginning of the experiment (because of dust, grease 

residues…). It is recommended to wash the sand to obtain a reproducible initial state. The 

procedure is:   
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a. Put the sand in a 0.5% dilute solution of TFD4 detergent and boil for 30-40 min. 

b. Rinse the sand under hot tap water for 15 min, and then boil for another 15 min. 

c. Rinse the sand with tap water first and demineralized water afterward. 

d. Dry the sand in an oven at 60 °C for 24 h. 

e. Prepare the sand and clay mix: Mix 98.5% of dried sand and 1.5% clay (by weight).  

f. To stabilize the sand-clay association, the mixture is saturated with tap water and oven-dry 

at 105 °C.  

g. After mixing and drying, this sand-clay mix is stored in closed containers.  

Hydric properties that we have determined of this sandy-clay soil are shown Figure 6 (see 

Garrigues, 2002 for more details) and can be used for converting water content to matric 

potential and for soil-root water modeling purposes.  

 

 
Figure 6. Retention curve (A) and hydraulic conductivity, expressed in a logarithmic scale 
(B) of the sand clay mix (98.5% sand-1.5% hectorite clay). The soil matric potential is 

expressed in hydraulic head units (meters). 

 

2. Rhizotron filling and plant culture 

a. The filling of rhizotron with the sand-clay mix is an important step in obtaining reproducible 

results. A layer of coarse sand (2-3 mm diameter), acting as a draining layer and preventing 

fine sand to leak out, is first poured into the rhizotron to achieve a height of about 2 cm. This 

height is recorded (hcoarse). The rhizotron is then weighted: this “empty” weight is recorded 

(Me).  

  A mass of sandy soil is prepared. This mass can be estimated from 1.7*Vrhizo, where 1.7 

g/cm3 is an upper bound of the bulk density of the final sand packing and Vrhizo is the inner 

volume of the rhizotron, estimated from width, length and thickness dimensions.   

  The mass (in excess) of sand is put into the rhizotron once. This can be achieved with a 

homemade funnel (with trapezoidal shape), which aperture and length fit the rhizotron. The 

funnel is adapted and fixed to the top of rhizotron mouth. The sand is poured and 

accumulated into the funnel at about the same height along the rhizotron, while a paper 

sheet closes the funnel’s aperture. Removing the sheet causes a regular fall of the sand. 

During the fall, sand is redistributed by collisions with the inner spacers enhancing 
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homogeneity of the packing.  

  Always with the funnel containing the remaining sand on the rhizotron, the sand is 

compacted by tapping along the 2 aluminum edge spacers with a small plastic hammer. The 

number of strokes shall be the same between each rhizotron made (~15-20). The weight of 

the dry, filled, rhizotron is recorded (Mdf) and the dry bulk density (ρd) as well as an 

approximation of porosity (θs) are given by: 

 

 𝜌𝜌𝑑𝑑 = (𝑀𝑀𝑑𝑑𝑑𝑑 −𝑀𝑀𝑒𝑒)/(𝑉𝑉𝑟𝑟ℎ𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑉𝑉𝑐𝑐𝑖𝑖𝑐𝑐𝑟𝑟𝑐𝑐𝑒𝑒) and 𝜃𝜃𝑐𝑐 = 1 − (𝜌𝜌𝑑𝑑/𝜌𝜌𝑐𝑐)  

 

where Vcoarse is the volume of coarse sand in the rhizotron (= hcoarse x Widthrhizo x 

Thicknessrhizo) and ρs = 2.65 g/cm3 is the solid density of sand grains.   

  The rhizotron is labeled and in order to get spatial references in images of the rhizotron 

for geometrical registration, crosses are drawn with a fine permanent marker at the corners 

of the rhizotron.   

b. The rhizotrons are water saturated by placing them vertically in a container large enough to 

accommodate them and rising slowly the water level in the container. Before saturating the 

rhizotron, aeration holes in the Plexiglas need to be covered by adhesive tape to avoid the 

sand to escape. The weight after saturation can be recorded to get a first measure of the 

saturated water content.  

Note: At dry state and once saturated, rhizotrons shall be handled precautiously in order to 

not change soil compaction. After drainage occurred, the sand inside the rhizotron will be 

more stable.  

c. Large seeds (e.g., maize) are pre-germinated on moist filter paper in Petri dishes and 

transplanted in rhizotron when radicle is about 1 cm long. A potting mix is added and 

moistened on top and side of the seed to maintain a favorable medium for seed 

development. Smaller seeds (e.g., Arabidopsis) are put directly on a moist potting mix layer 

(about 3-4 mm high).  

d. To limit evaporation from top soil in rhizotron, a layer of coarse sand (or expanded clay) is 

added at the top of the rhizotron (the mass added is recorded). Rhizotron are covered on 

top and sides with opaque plastic sheets to protect them from light (root growth, algal growth) 

and evaporation.  

e. During plant growth in a growth chamber, rhizotrons are irrigated with a nutrient solution 

adapted to the plant. Frequent irrigation is necessary in order to not water stress the plant 

in the thin sandy medium. The irrigation can be done by automated drip irrigation to maintain 

the soil at field capacity (for example ~10-15 ml each 4 h during the day period). When 

plants are developed, transpiration may reach 1-10 g/h depending on the plant, its age and 

potential evapotranspiration. During this cropping phase, water lost by transpiration needs 

to be replaced by irrigation. Evaluation of transpiration can be done by weighing the 

rhizotrons regularly. 
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Note: A modified Hoagland is often used (see Recipes–Table 1). 

f. The rhizotrons can be installed vertically, but if one wants to follow root growth, rhizotrons 

can be tilted approx. 30-35° to get roots growing along a PMMA face. Roots can be followed 

through time by manually tracing with permanent markers on a transparency film fixed on 

the rhizotron face, or by taking a picture with a further process of root segmentation, if 

contrast/resolution are good enough.  

g. At the end of the whole experiment, the rhizotron is laid horizontally, a PMMA face removed 

and roots can be exposed (possibly using a brush) for root recording (manually with a 

transparency film or by taking a picture).  

3. Imaging of rhizotrons 

Timing of an imaging experiment:  

For a water shortage experiment or following a rewetting, the rhizotrons are imaged regularly. 

For a drying experiment, an imaging frequency of 2 h is enough. Depending on the plant type, 

age and climatic conditions in the growth chamber, the water shortage experiment may last from 

3 days (e.g., maize, lupine) to 8-10 days (e.g., Arabidopsis) before water in the rhizotron is 

nearly completely depleted.  

Warmup, location of light box and camera:  
Light emission of fluorescent tubes of the light box will increase after switching on and a warm-

up of about 10 min of the lamps is recommended before the first image is recorded. The light 

box and camera can be placed ideally in the growth chamber where the rhizotron stays, 

minimizing transport, or in a dedicated room. In either case, to avoid undesirable light reflection 

on the walls, black sheets/tarps are put on side walls between rhizotron and camera. A specific 

casing can also be made protecting from outside light, black inside, with a rectangular or 

truncated pyramidal shape enclosing the camera and arriving at the light box. To avoid at most 

geometric errors, the camera and rhizotrons (cf. Step A4) shall stay at the same place between 

images, and the camera needs to be fixed and not moving. Typical distances between rhizotron 

and camera are from 60 cm to 2 m, depending on the size of rhizotron and camera lens used.    

Camera adjustments:  

In a typical water shortage experiment, the first image of the time sequence would be the 

reference image at (near) saturation of the series. This can be done by increasing irrigation a 

few hours before starting the experiment. The water saturated image is the brightest image in 

the experiment, and the camera parameters are set at this step (aperture and possibly shutter 

speed) for the whole experiment in order to get a bright but not saturating image (i.e., pixels 

values lower than 255 for 8-bit image). This can be verified with Fiji/ImageJ software (Schindelin 

et al., 2012) with the threshold function. Typical settings are aperture f/4 to f/8, shutter speed 

1/125 to 1/20 second. In order to minimize noise and light variation effects, at each 

measurement time, 3-4 images are taken successively which will be averaged later.  
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Note: Full saturation can also be done at the end or beginning of the experiment by rising water 

level slowly in a container with the rhizotron. Care should be taken to close lateral aeration holes 

(with tape). 

Weighing of rhizotron:  

Just before each image acquisition, the rhizotron is weighed to estimate the transpiration and 

mean soil water content.  

4. Establishing a water content calibration with the water content calibration cells 

a. Sandy soil samples are prepared at different values of gravimetric water content (0, 2, 5, 7, 

10, 15, 20%). To this end, a dry mass of soil (Ms) is prepared in excess to fill each cell (cf. 

Step A5; about 80 g for each cell described in Step A5). A mass of water (Mw) is prepared 

to get the desired gravimetric water content percentage W: 𝑀𝑀𝑤𝑤 = 𝑀𝑀𝑐𝑐 × 𝑊𝑊/100. The dry soil 

is distributed over a dish in a thin layer and the amount of water is spread over the soil with 

a spray. The soil and water are thoroughly mixed, transferred into a plastic or glass container, 

which is sealed and stored in a cool place for 48 h (to get moisture equilibrium).  

b. With the front side of the calibration cell removed, a mass of moist soil (Mm) is weighed to 

reach a bulk density of 1.65 g/cm3 in each cell. This mass can be calculated with: 

 

𝑀𝑀𝑚𝑚 = 𝜌𝜌𝑑𝑑𝑉𝑉(1 + �
𝑊𝑊

100
�) 

 

where, ρd =1.65 g/cm3, and V is the volume of the cell to be filled.  

 

The soil is deposited along the cell, pressed and leveled (using the aluminum bars) to fill 

the entire cell. This is repeated for each calibration cell. Cares need to be taken to not leave 

sand on aluminum bars. 

Note: It is useful to train before making the final calibrated cells in order to obtain as most 

homogenous filling as possible. Another option is to fill cell from the top and to compact 

from the top each 3 cm. However, this results in heterogeneous layered medium but, from 

images, the mean pixel intensity over the cell is representative of the mean water content. 

c. Unused sand in excess is collected to determine the actual gravimetric water content. To 

this end, the moist soil sample is weighed, then dried for 24 h at 105 °C and reweighed. The 

gravimetric water content is the ratio of water mass (the difference between moist and dry 

soil) to the dry soil mass. 

d. Silicon grease is added along aluminum bars and the calibration box closed with black tape 

around the edges of the box. A picture of the calibration cell with the light box is taken in the 

same conditions as rhizotrons (cf. Step B3).  

e. As for rhizotron and image processing, the calibration cell is brought to saturation. This is 

done by adding water slowly with a micropipette in each cell. The range of mass of water 

(Mw) to be added can be estimated with: 
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𝑀𝑀𝑤𝑤 = �0.38 − 1.65 �
𝑊𝑊

100
��× 𝑉𝑉 

 

where, 0.38 is the theoretical volumetric water content at saturation for a medium having a 

bulk dry density of 1.65 g/cm3. The saturated calibration cell is let to equilibrate for a few 

hours and then a picture of the saturated calibration cell with the light box is taken again.  

f. The calibration is opened and the sand of each cell is completely sampled. Weigh these 

moist soils, and then dry in an oven for 24 h at 105 °C and reweigh. The gravimetric water 

content approximating saturation can then be calculated as well as the dry bulk density of 

each cell, if the volume of the cell is determined. 

 
Data analysis 
 

1. Processing of the images of rhizotron for water content 

Once acquired in the light transmission experiment, the images are processed:  
a. If needed: conversion of raw images to uncompressed tiff file (software supplied with 

camera). 

b. Averaging image replicates: using Fiji (using stacks: File → Import → image sequence; and 

then Image → Stacks → ZProject → Average Intensity–A macro can be recorded) or with 

homemade software. 

c. Conversion of RGB images to grey levels, with Fiji (Image → Type → 8 or 16 bits, depending 

on color depth of image) or using Netpbm (Linux software). 

d. Geometrical registration of the images of the time series. The first image of the time series 

acts as a reference. With Fiji the StackReg plugin can be used (Plugins → Registration → 

StackReg) or other registration capable program (e.g., homemade program makes use of 

marks in the image: written crosses and screws for example, with polynomial rectification 

and resampling with interpolation). The true size of pixel can be calculated from a known 

length in the image (it will be the same for each image) and camera (x, y) number of pixels. 

e. Adjusting images according to a grey scale reference. Images of the time series can be 

referenced either to the grey values of the colorimetric scale (from 0 to 255 see Step A3 in 

Procedure) or to the intensity value of the grey colorimetric scale of the first, water saturated, 

image. Sampling the intensity of grey values of the colorimetric scale in each image can be 

done in Fiji by defining masks on each of the colorimetric cells with the rectangular selection 

tool (cf. http://imagej.nih.gov/ij/docs/guide/146-29.html to create binary masks). These 

masks are used along with the ROI manager (Analyze → Tools → ROI manager) where 

masks can be applied to each image and measured (i.e., getting the mean pixel value, 

standard deviation in the region of the mask). For each image, the correspondence between 

the mean pixel intensity of the greys of the studied image and the reference value (i.e., the 

0 to 255 eight colorimetric values defined in Step A3 or intensities of the colorimetric cells 
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of the water saturated image) can be established using the calibrate function (Analyze → 

Calibrate) or the LUT editor plugin in Fiji. Alternatively, homemade programs which make 

average of the defined colorimetric zones and adjust the studied image with a cubic spline 

to the reference colorimetric scale are available. 

f. Calculating the water content of pixels in images with the fitted calibration equation (5):  𝑆𝑆 =
𝜃𝜃
𝜃𝜃𝑠𝑠

= 𝑎𝑎 + 𝑏𝑏 ln � 𝐼𝐼𝑣𝑣
𝐼𝐼𝑣𝑣𝑠𝑠
� (cf. below “2. Processing of calibration cell” for fitting). This calculation can 

be done with Fiji using the image calculator and Math functions (Process → Image 

Calculator, or Math) and selecting 32 bit images type (float values for water content) for the 

result. For each image of the time series: 

i. Calculate the saturation ratio of images: 𝐼𝐼𝑣𝑣/𝐼𝐼𝑣𝑣𝑐𝑐, where 𝐼𝐼𝑣𝑣 is grey levels of pixels of the 

image of rhizotron at a given time and 𝐼𝐼𝑣𝑣𝑐𝑐  those of the image of the rhizotron at 

saturation (with Image Calculator in Fiji, using the Divide function). 

ii. Calculate image of water saturation 𝑆𝑆 = 𝑎𝑎 + 𝑏𝑏 ln � 𝐼𝐼𝑣𝑣
𝐼𝐼𝑣𝑣𝑠𝑠
� with Log, Multiply, Add functions 

of Math in Fiji (or alternatively use the macro function of Math to code the equation 

directly). 

iii. Calculate water content image (θ) from saturation with 𝜃𝜃 =  𝑆𝑆 × 𝜃𝜃𝑐𝑐 with 𝜃𝜃𝑐𝑐  the mean 

value of water content at saturation of the rhizotron determined from weight 

measurements (see Steps B2 and B3) 

iv. The rhizotron part of the result image is cropped and saved in tiff (and text file if needed), 

for further calculation/processing. Again, homemade programs can do that calculation 

part. 

g. Post-processing of the water content image series includes the calculation over the 

rhizotron of the mean water content, which will be compared to estimated water content 

from weight measurements. Specific treatment related to water variations includes 

conversion of water content into water potential, calculation of images water uptake rate 

with time (time image differences), estimation of the maximum depth/width of uptake, 1D 

mean profiles (and standard deviation) of water content, water uptake along the rhizotron. 

If images of the root system are co-registered with water content images, then processes 

at the soil-root interface (for water) can be examined, such as local or mean drawdown with 

distance to root, root type or age. The relationship between root density and uptake or 

between root growth and water content or potential can also be obtained.   

2. Processing of the calibration cell 

The calibration cell enables to fit a, b in equation (5):  𝑆𝑆 = 𝜃𝜃
𝜃𝜃𝑠𝑠

= 𝑎𝑎 + 𝑏𝑏 ln �1 − ∆𝐼𝐼𝑣𝑣
𝐼𝐼𝑣𝑣𝑠𝑠
� =  𝑎𝑎 + 𝑏𝑏 ln � 𝐼𝐼𝑣𝑣

𝐼𝐼𝑣𝑣𝑠𝑠
�. 

The images of the calibration cell are processed as for the rhizotrons (cf. above step 1), except 

that the value of ln � 𝐼𝐼𝑣𝑣
𝐼𝐼𝑣𝑣𝑠𝑠
� are estimated from mean values over the same region of interest in 

each calibration cells for initial and saturated images. The (a, b) coefficients of the calibration 

function in eq. 5 are estimated from linear regression between water saturation and ln � 𝐼𝐼𝑣𝑣
𝐼𝐼𝑣𝑣𝑠𝑠
� 
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(Figure 7). As the regression changes at low water contents, a second set of parameters is 

needed in the low saturation range (lower than about 3% volumetric water content, Figure 7).  

  The colorimetric scale adjustment of the calibration cell is referenced to the first image of the 

time series of each rhizotron, resulting in a slightly different calibration equation for each 

rhizotron.  

 

 
Figure 7. Calibration derived from images of calibration cells between water saturation 

S=θ/θs and  𝐥𝐥𝐥𝐥 �𝟏𝟏 − ∆𝑰𝑰𝒗𝒗
𝑰𝑰𝒗𝒗𝒗𝒗
�. The equation of calibration is 𝑆𝑆 = 𝑎𝑎 + 𝑏𝑏 ln �1 − ∆𝐼𝐼𝑣𝑣

𝐼𝐼𝑣𝑣𝑠𝑠
� (see eq.5) where a 

and b are fitted by linear regression. Two regressions are needed. 

 

3. Validation of estimated water content of rhizotron from image processing 

To get rid of possible residual effects of variations in compaction between calibration cell and 

rhizotrons a final test consists in comparing mean volumetric water of rhizotrons estimated from 

calibrated images and from weighing of rhizotron trough time. This normally results in a 

regression line with R2 > 0.99, but if the slope is nearly equal to 1, a small bias (about 1% in 

volumetric water content) may appear. In that case, the water content estimated from images 

can be converted to “true” water content (from weight measurements) by this regression 

equation.  

4. Processing images of root systems 

If the root system was traced on a transparency film on front of the rhizotron, the film can be 

scanned and the resulting image segmented with IJ_Rhizo software (Pierret et al., 2013) for 

example. A way for vectorizing complex root systems when the rhizotron is disassembled and 

root system exposed can be found in Lobet and Draye (2013). If following root growth either 

from transparency film drawings or images of rhizotron trough time is of interest, the SmartToot 

software (Lobet et al., 2011) would be usefully used as it enables semi-automated tracing of 
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roots on an image series. Outputs such as growth, topology, lateral density, diameters can be 

obtained.  

  Whatever the root processing software, if the root system in rhizotron is segmented from an 

image at the same time as the imaging experiment for water content, coregistration of the 

images of the segmented root system and of the water content in the rhizotron enables to relate 

root parameters (root density, root age, root types, growth...) and water content or uptake in soil.  

5. Going a step further: Use of imaging experiment in modeling 

Light transmission imaging of plant water uptake has been designed initially to verify the 

consistency of detailed modeling of root water uptake. This modeling couples root system 

architecture, regulation of water flow into and along the root system, mechanistic water transfer 

in the soil (Doussan et al., 1998; Doussan et al., 2006). This modeling approach has been 

extended since (Javaux et al., 2008; Schneider et al., 2010). The modeling of light transmission 

imaging, in the case of more or less tap rooted Lupine root systems, showed that uptake is 

driven by local soil-root interactions at the single root scale, linked to variation in soil hydraulic 

conductivity near the root and root radial conductivity. These interactions are modulated at the 

root system scale by the water distribution and the root axial conductance (Doussan et al., 2006). 

Variations in root system architecture and distribution of root hydraulic conductance, defining 

different root systems phenotypes, will give rise to variations in water uptake pattern. Testing 

these various phenotypes with detailed water uptake models in combination with imaging results 

of water content, can give access to estimations of hardly measurable parameters such as root 

hydraulic conductivity, distributed root water uptake rates or root xylem water potential. 

Combination of modeling and experiment may also help in testing biological and physiological 

assumptions, such as ABA production and regulation of water fluxes (Lobet, 2013). With the 

modeling, supported by imaging experiments, plant behavior (e.g., for different root phenotypes) 

can be extrapolated to other soil/climate conditions (e.g., for looking at the water uptake 

efficiency), guiding experimental verifications (in the field or controlled conditions) in a later step.  

 
Notes 
 

The 4 mm void, filled with soil, thickness is a good compromise to get enough light through the 

rhizotron and enables a good contrast between dry/wet states of the sandy soil used. Slightly larger 

thickness can be used to accommodate thicker roots (up to 6 mm) but at the expense of lower 

contrast.   

 

Recipes 
 

1. Modified Hoagland solution (Table 1) 
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Table 1. Composition of modified Hoagland solution. The Iron content is doubled in this 

solution (adapted from Lobet and Draye, 2013)  

Component  Stock solution ml/L 

2 M KNO3  202 g/L 25 

2 M Ca(NO3)2·4H2O   236 g/0.5 L 25 

Fe-EDTA  15 g/L 1.5 x 2 = 3 

2 M MgSO4·7H2O  493 g/L 1 

1 M NH4NO3  80 g/L 1 

1 M KH2PO4  136 g/L 0.5 

Minors:   1 

 H3BO3 2.86 g/L  

 MnCl2·4H2O 1.81 g/L  

 ZnSO4·7H2O 0.22 g/L  

 CuSO4 0.051 g/L  

 H3MoO4 or 0.09 g/L  

 Na2MoO4·2H2O 0.12 g/L  

(pH 6.0 w/ 3 M KOH) KOH 3 M 163 g/L  
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